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BEILSTEIN'S HANDBUCH ... & ... GMELIN'S HANDBUCH ...

Beilstein's Handbuch der Organischen Chemie was, until the 1980's, considered an absolutely
essential subscription in any chemistry research library. Since that time, a dramatic increase in the number of
new organic compounds, a decline in the study of German language, and the relative weakness of the US$ vs.
the German DM (which increased subscription costs to ~$40K by 1990), led to Beilstein's virtual unaffordability
in all but the largest university and industry libraries. In addition, the print volumes continued to be out-of-date,
which has been a chronic problem since the inception of the Handbuch. For example...
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Caltech cancelled its Beilstein subscription in 1986, at the end of the 4th supplement (Erganzungswerk
IV), because the literature coverage was only complete through 1959 and there was virtually no prospect that
this situation would significantly improve. This became a fairly universal view as Beilstein's 3300 Handbuch
subscriptions in 1965 were reduced to 294 by 1990.

The Beilstein Institute finally realized that they had to create an electronic version of their work that was
reasonably up-to-date. Following the editorial preparation of the 5th supplement, they refocused their coverage
to 120 significant organic chemistry journals (1980+) and began development of an online / internet based
product - Beilstein CrossFire. It was also decided to publish the entire database in English (using a German to
English translation algorithm for the existing data).

Beilstein currently covers about 180 journals, with an emphasis on synthesis, and a time lag between 9-
12 months. This allows chemists to search for data on more than 9M organic compounds (including salts and
addition compounds, amino acids, carbohydrates, nucleosides, porphyrins and steroids) and more than 9.5M
reactions. Beisltein does not include polymers & has not covered patents since 1980.

The Beilstein Database contains searchable synthetic (preparation, formation, isolation, & purification),
chemical (including characterization and analysis), physical, structural and biological data from nearly 2M
literature references (since 1789) which include author abstracts since 1980. Sophisticated graphical and text
based query options and hyper-linking capabilities are provided and the ability to use ranges of chemical and
physical data as search terms greatly enhances its value.

The Gmelin Handbuch ... suffered similar problems with literature coverage and pricing. Instead of
providing comprehensive coverage of the literature over specific time periods, Gmelin offered comprehensive
coverage of specific elements and their compounds with elements having 'lower' Gmelin numbers. This
system was necessitated by the convenience of having a metal (Nickel, for example,) and its compounds with
non-metals (e.g. NiCl2) grouped together. This approach resulted in very uneven coverage. Sodium covers
the literature thru 1960, but Potassium only thru 1936. Mellor's Comprehensive Treatise ... Supplements
provides updates on the halogens, alkali metals, nitrogen and phosphorus. The handbooks published after
1975 are not included, as Gmelin transitioned to indexing ~120 of the most important journals beginning with
1976.

Gmelin is a comprehensive collection of factual data on inorganic, organometallic and coordination
compounds, alloys, glasses, ceramics and minerals. The Gmelin Database currently contains data for nearly 2
million compounds & more than 1.5M reactions from about 1M literature references (since 1772). The
database includes information about analytical chemistry, atomic physics, ores, electrochemistry,
geochemistry, coordination chemistry, corrosion and passivity, crystallography, geology, metallography,
metallurgy, mineralogy, physical properties (crystallographic, mechanical, optical, magnetic, electrical), toxicity
and hazards, economic and statistical data.

Caltech's annual subscription allows for UNLIMITED access and searching by faculty, staff or students
at any time, from any location on campus.



MDL CROSSFIRE V6

What is CrossFire?
e CrossFire is a search system with a locally loaded client interface (Beilstein Commander)
which provides access to the CrossFire server at the University of Wisconsin - Madison.
A handout describing both the databases and search techniques is available at:
http://library.caltech.edu/publications/beilstein/BeilsteinGmelinV.6.pdf

What is Beilstein?
e A database of over 35M property records for over 9M organic compounds (including salts,
mixtures, peptides with <12 amino acids). Polymers are not indexed.
e Covers the scientific literature from 1771 to the present, with over 1.9M articles.
Currently indexing 175 journals http://www.mdl.com/products/pdfs/BSJournals.pdf
e Reactions (9.5M) and properties are critically evaluated, with references to original articles.

What is Gmelin?
e A database of property records for over 2.1M inorganic and organometallic compounds
(including coordination compounds, alloys, ceramics, minerals, etc.).
e Covers the scientific literature from 1772 to the present, with over 1.1M articles.
Currently indexing 62 journals http://www.mdl.com/products/pdfs/GMJournals.pdf
e Reactions (1.65M) and properties are critically evaluated, with references to original articles.

How can | access CrossFire V6?
e Workstations with the V6 client are available in the Millikan, SFL, Astro & Geology libraries,
under the START MENU (as MDL Crossfire Commander v6).
e Macintosh or MS Windows versions are available for downloading to Caltech workstations
from the library web page at: http:/library.caltech.edu/publications/beilstein/default.htm

CrossFire features:

e Autonom - generates an IUPAC name from an organic structure.
e Text Searching - Search text words or author names (article titles/abstracts 1980+).

e Structure Searching - (Beilstein/Gmelin can be searched simultaneously).
Either draw a structure / sub-structure, modify a (Beilstein) template (under File menu), or
search with a name and copy the structure from the 'short display’. Combine with property
or text terms (e.g. NMR, malaria). Autosearch may provide additional retrieval.

e Reaction Searching (both Beilstein and Gmelin) by:
Specify the role (reactant and/or product) of a compound or sub-structure in a reaction.

e EDS (Easy Data Search) - Tables or predefined forms
Names or portion(s) of chemical names. CAS Registry numbers. Author names.
Property values and range searching (e.g. melting point between 100 and 102 degrees).
Reaction data, Solubility, Spectra.

e Combination Searching
Combine structures / substructures with property terms (e.g. NMR) in B or G (not both).
Search for text and/or structures in B & G simultaneously.


http://library.caltech.edu/publications/beilstein/BeilsteinGmelinV.6.pdf
http://www.mdl.com/products/pdfs/BSJournals.pdf
http://www.mdl.com/products/pdfs/GMJournals.pdf
http://library.caltech.edu/publications/beilstein/default.htm

Getting Started on a Library Workstation
From the Start Menu - Programs - MDL CrossFire Commander V6 2>
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Structure or data searching: Click on the '‘Crossed Red Arrows'. After connection, select either
Beilstein (organic) or Gmelin (inorganic/organometallic), or both. The default is the last one used.
Text (in substances, reactions or citations) and/or structures can be searched simultaneously.
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Structure Searching requires double clicking in the Structure Window, or clicking the Structure icon.




Drawing Chemical Structures -- (Crossfire or ISIS/Draw editors)
Commander screen - Options > Structure Editors - MDL ISIS or MDL Crossfire

The Structure Editor screen has a toolbox, and atom / bond / template / ring bars.
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The toolbox along the left side of the screen provides a set of tools for drawing, selecting, activating,
erasing, rotating or zooming structures.
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The atom/bond bars offer a selection of default atoms and bond types for the Edit tool. Atoms or
bond types not shown may be specified from either the Atom or Bond pull-down menus, although it is
usually easier to draw a carbon skeleton and change atoms and bonds as necessary.

Click on the Edit (pencil) icon to draw a structure. The default atom and bond type are carbon and
single. Click and hold down the left mouse button. Drag the mouse to the desired end point of the
bond; Release the mouse button to terminate the bond and place the second atom. Repeat (Click
and hold, Drag, Release) to continue drawing atoms and bonds.

Atoms and bonds already drawn can be changed by simply changing the default atom or bond (on
the Atom Bar) and, while holding down the shift key, click on the atom or bond to be changed. Do
NOT draw in hydrogen atoms.



To erase a portion of a structure that has been drawn, select the Eraser tool from the tool bar.
Position the eraser (the tool shows a "B" or "A" when positioned correctly) and click on each
atom/bond as needed. To erase a larger portion of a molecule, use the Lasso tool to circle the area
to be erased and click on the Scissors Icon. The screen can be cleared by clicking Delete All under
the edit menu. Undo under the edit menu will undo the last operation.

To move or rotate a molecule, first activate it (by double clicking one of the atoms or bonds) with the
Select tool.

To access the full range of options for atoms and bonds, use the Edit tool (pencil) to click on a bond
or atom (the tool shows a "B" or "A" when positioned correctly). Clicking on an atom displays the
Atom Attributes box (see figure below, right side), which allows changing the element, free sites,
hydrogen counts, etc. Clicking on a bond displays the Bond Attributes box (see figure below), which
allows changing the bond type, topology, etc.
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Pre-defined Generic Groups and Atom Lists

Pre-defined Atom Lists (e.g. Any Halogen, Alkali Metals, etc.) and Generic Groups (e.g. Alkyl, Aryl,
etc.) may be added to a structure by clicking the ‘down arrow’ in the atom box on the function bar and
selecting ‘Generics’ This displays the Generics menu shown below. Selecting one of the pre-
defined atom lists or generic groups, changes the Edit tool (pencil) default to that atom list or generic
group. This is particularly useful for repeatedly adding the same atom list or generic group.
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Alternatively, for adding a single group, you can double click an atom with the Edit tool, then click the
down arrow in the Atom Attributes Symbol Box and select ‘Generics...” from the menu. This also
displays the Generics menu shown above. Click on one of the pre-defined atom lists or generic
groups. Click OK on the Generics menu and click OK again on the Atom Attributes box. This
changes the selected atom.

Creating User Defined Groups and Atom L.ists

Atoms: Click the atom in the structure, which needs to be variable. Type ‘Al’ in the Atom Box and
click OK to make the change. Next, click the ‘An’ button in the Tool Box (left side), and the ‘Atom List
Number’ box will appear. Click OK to display a ‘Define Atom List A1’ periodic table. Click as many
elements or element groups as needed and click OK. A list of the all the selected atoms will appear
in the Structure Editor window.

Groups: Click the atom, which will be the variable group in the structure. Type ‘G1’ in the Atom Box
and click OK to effect the change. Next, draw a group in the Structure Editor window, ‘Select’ a
group structure (i.e. by double clicking an atom or bond with the select tool) and click the ‘Gn’ button
in the tool box. Set G=1 and click OK. Repeat for additional groups. One atom in each group must
be designated as the attachment point. Click on this atom (with the Edit tool), to display the ‘Atom
Attributes box. Click ‘Set User Defined‘ and then click ‘Attachments’. Click ‘1’ in the ‘Attachment
Points’ box and click OK (in that box). Then click OK in the ‘Atom Attributes’ box.



TEMPLATES (Both Beilstein & Gmelin)

Clicking on a menu ring, or clicking on one of the structures in the Group Templates folder,
transfers an 'active’ structure to the Structure Editor window. This 'active' structure may be moved,
resized or rotated. Click outside the 'box’ to 'deactivate’ the structure. The resulting structure may be
further edited (after clicking on the edit tool).
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Templates for Complex Structures (BC2000 has Group and User Template files)

The following group template files are available:

AMINACID.BSD Amino Acids POLYATOM.BSD Coordination Types
AROMATIC.BSD Aromatics PORPHYR.BSD Porphyrins
CHAINS.BSD Chains RESIDUE.BSD -NO2, -COOH, -S03
CYC_ALK.BSD Cycloalkanes STEROIDS.BSD Steroids
HETEROCY.BSD Heterocyclics SUG_OPEN.BSD Sugars (open)
NATPRN.BSD Cyclic N-containing SUG_RING.BSD Sugars (cyclic)
NATPRNOS.BSD Cyclic N-, O-, S-containing TERPEN.BSD Terpenes
NUCLEOSI.BSD Nucleosides

After drawing a structure, click on the Crossed Red Arrows - Beilstein Commander.

Next, under the Query Menu, click 'Structure Query Options'. This gives options for adding isotopic variants,
radicals, ions, etc. A structure search can be combined a physical property data search (e.g. click Spectral
Data (under Easy Data Search menu) and check NMR), in either Beilstein or Gmelin (not both).



Searching and Displaying ...

Click the Start Search button. CrossFire will search the database and report how many compounds match the
search criteria (i.e., how many "hits").
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Display Hits Screen Basic Information

First (under the View Menu) click 'Short Display’, to identify compounds of interest among a large set. Clicking
the 'Field Availability' icon, or from under the View Menu, provides a quick display of available properties.

The 'All Fields'/'Field Availability' mode provides a convenient display for compounds with extensive properties.

The 'Field Availability' display provides a scrollable property list that can be clicked to quickly display specific
data fields.

To sequentially view the text records, use the center two arrows on the menu bar at the top of the screen.
Use the outer two arrow buttons (the ones pointing to a vertical line) to move to either the first or the last hit.
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Underlined numbers in various colors seen in the text records are hyperlinks to the Beilstein record
for another compound, reaction or citation. To move to the linked record, click on the highlighted
number. Moving back and forth between the original and linked records is done with the back and
forward buttons (shown below).
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'Reaction View' under the View Menu provides for display of 'substance as a reactant' or 'substance
as a product'. To quickly search for preparations of a specific organic compound, do a compound
search, go to the 'View' menu and click on 'Reaction View' and 'Substance as a Product'.
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Reaction Searching

There are currently about 8.7 million structure searchable reactions in Beilstein and 1.5M reactions in
Gmelin allowing you to build complete reactions or half reactions and search for them.

First draw the reactant and/or product molecules, in the Structure Editor. Then switch to ‘Reaction
Editmode’ by clicking the ‘Reaction Attr.” Button on the tool bar.
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The function bar then changes to allow reaction roles to be set. ‘Select’ the appropriate molecule
(with the select tool) and click either the Reactant or Product button to define that molecule's role in
the reaction. Half-reactions can also be defined by drawing and defining only a reactant or a product.

The structure of a molecule can be changed by switching back to the Structure Editor, after
‘Selecting’ the molecule, and using the ‘Undefine’ button, to delete product and reactant
assignments.

Click on the BC button to transfer the structure to Beilstein Commander, and click 'Start Search'.

Search Tips:

Preparative reactions can be quickly displayed, after a compound search, from the 'View' menu »>
Reaction View - Substance as a Product.

Structures can also be copied into the Structure Editor from the Short Display under the View menu.
First search for a model compound by name (e.g. Ferrocene). Highlight the 'short display' structure
by clicking once and then from the Edit menu, select 'copy structure to SE'.

To move a structure -- 'Select' the structure / drag the small black square
To expand or contract a structure -- 'Select' the structure / drag the side of the 'box'.
To copy a structure -- select structure / shift key / drag

Beilstein Lawson Numbers define a structural similarity. After finding the Lawson Number for a model
compound and then using it as a search term, results are restricted to substance classes without
actually drawing a structure and searching for it.



CUSTOM DISPLAYS AND PRINTING

Records in the database can be hundreds of pages long. To avoid printing unwanted information, you
can:

1. Use the check boxes to designate specific ‘fields' in a record, and click on the print icon
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2. Under the View Menu click both All Fields and Field Availability. The Field Availability list can
be alphabetized (in Gmelin, however, the order is case sensitive). The default order corresponds to
the print volumes (chemical properties, physical properties, etc.). For printing selected fields, click
Remove all checkmarks and check off fields (as shown) and click Apply selections to User View
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This limits the Display Hits window to just the desired fields, which can then be printed. The full
display is regenerated by clicking All Fields under the View Menu.

3. Text can easily be copied and pasted into e-mail messages, MS Word and Excel documents.
Structure images must be first transferred to the Structure Editor, and from the Edit Menu, click
Copy All and in MS Word, paste special Picture.



AUTONOM

AutoNom (which is included in the client software) automatically generates IUPAC names from
organic chemical structures, using the Beilstein Structure Editor.
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DATA (NAME / PROPERTY) SEARCHING

Data searching requires double clicking the Fact Editor or one of the quick search options (e.qg.
Physical Data). Beilstein display is shown. Gmelin offers additional options. The magnifier button
opens a dictionary to check spelling, etc.
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BEILSTEIN NOTES:

Some of the original print database was not translated into English. The ‘Other Conditions’ line in the
Reaction Field, for example, is in German. A Beilstein German-English dictionary is available at:

http://www-sul.stanford.edu/depts/swain/beilstein/bedict1.html

In the creation of Beilstein CrossFire, the algorithm used to update the very cryptic abbreviations,
used in the early years, assigned the current abbreviation to journals that have changed title over the
years. For example, 'chem.ber.' is given as the abbreviation for Ber. Dtsch. Chem. Ges.(1868-1946)

Beilstein discontinued coverage of patents in 1980. Although a few scattered 19" and early 20™
century patents were covered, the strength of Beilstein’s patent coverage begins in 1925. About 2K
patents were indexed in 1930, steadily increasing to 5000 in 1956 and to 15K in 1966. Coverage
began to slowly decrease dropping to about 10K patents in 1979.

Chemical names in Beilstein generally reflect usage in the article. Since 1992, Chemical Abstracts
Registry Numbers are not assigned, unless they appear in the article. It is advisable to rename a
compound according to IUPAC rules (e.qg. tert-butyl-methyl ether - 2-methoxy-2-methyl-propane) or,
better yet, do a structure search.

Simply drawing a cis or trans structure will NOT define it for a structure search. The results will
include both cis and trans compounds (the bonds are labeled E and Z in the Short Display). The wavy
bonds refer to mixtures of E & Z isomers or a compound of unknown configuration.

Range searching is allowed. For example, you can search for compounds with melting points greater
than 500 degrees (mp>500 in a Tabular Query). Searching for a melting point of 134 degrees will
retrieve compounds with a melting point listed as 133-135 degrees.

Coverage of the literature is somewhat inconsistent in Beilstein. For example, Organic Syntheses has
not been covered since 1979 (since it is not a journal). Coverage of SynLett did not begin until 1997,
and coverage of Organic Letters did not begin until mid-2000. In general, articles are not indexed
until about one year after publication.

In the mid-seventies, there was a new definition of "inorganic" and "organic" compounds.
Beilstein currently indexes compounds that contain carbon and the yellow-shaded elements in the
periodic table at: http://www.library.wisc.edu/libraries/chemistry/beilstein/beilsteinelements.htm
The remainder are indexed by Gmelin.

The following are NO LONGER Beilstein compounds: CO, CS, CO2, CS2, COS, C302, C3S2,
H2CO3, HCN, HOCN -- their sulfur analogs and metal salts/complexes, Dicyanogen (C2N2),
Phosgene (CCI20), Metal Carbides, Metal salts of formic, acetic and oxalic acid, Fullerene and
Carboranes. 'Gmelin' compounds included in Beilstein are organometallic compounds known before
1980, such as Ferrocene, Dimethyl Mercury, etc. Searching both databases is strongly
recommended for complete retrieval.


http://www-sul.stanford.edu/depts/swain/beilstein/bedict1.html
http://www.library.wisc.edu/libraries/chemistry/beilstein/beilsteinelements.htm

GMELIN NOTES:

1. For all compounds with molecular units (e.g. small molecules like H20O and coordination
compounds) a structure search or substructure search is recommended. If the connectivity of ligands
is not unique, coordination compounds may only be searched as fragments (e.g. a substructure of the
ligand in combination with complexed metal).

2. For compounds without molecular units, e.g. solid state materials, salts (like NaCl), formula
searching is the preferred. Note that H20O is included in component MF for hydrates. To reduce the
hits, restrictions can be set, e.g. number of components. nc=1 is a single phase compound --
K4Fe(CN)6. number of fragments. nfrag=2 -- K and Fe(CN)6. number of elements. ne=4 -- K, Fe, C,
and N.

3. Searching for chemical names is another possibility. However, not every compound has a
systematic nhame, since only names given in the article text are entered. Furthermore, since chemical
names of inorganic compounds are less standardized than organic ones, structure or formula
searching is recommended. Searching with chemical names can be useful if a ligand is very complex
to draw. Search for the ligand by name (with asterisks, e.g. *ferrocene?*) to retrieve compounds
containing this sub-structure. The desired structure can then be loaded into the structure editor, and
altered as needed.

4. In contrast to Beilstein, Gmelin indexes polymeric compounds. These may be searched as
structures, with the structure editor. For example, enter a Ge atom (with max free sites). Return to
Commander and (in the fact editor) enter [type=polymer]. This will retrieve all Germanium polymers.
Alternatively, you can attach two generic groups (e.g. Aryl or Acyl) to retrieve, for example,
compounds with a [Aryl--Ge--Aryl] repeating structure (with a Ge backbone).

5. Polymers can also be searched by monomer molecular formula (e.g. C12H10Ge will retrieve
polydiphenylgermane. In SFS, this would be searched as (C12H10Ge)x.

6. More than 99% of the original Gmelin Handbook thru 1975 is indexed in CrossFire Gmelin. Some
material was added to Beilstein (a matter of re-definition) and some volumes (e.g. Geology of Iron)
were omitted. Handbook volumes published after 1975 were not indexed for CrossFire Gmelin.

Beginning in 1976, Gmelin began indexing the 120 most important journals in inorganic and
organometallic chemistry. There is currently a major effort to bring the database up to date, by
adding material from 1995-2001. The GDCh is responsible for excerpting rticles from 1995-2000 by
the end of 2004. Coverage of new journals is problematic. Inorg. Chem. Commun. (1998+) will be
indexed from 2003+ . Both Z. Kristallogr. New Cryst. Struct. and Acta Crystallogr. Sect. E are under
evaluation.

BEILSTEIN & GMELIN'S RELATIONSHIP TO SCIFINDER SCHOLAR

SciFinder Scholar (Chemical Abstracts plus) and Beilstein/Gmelin have different criteria for indexing
articles that describe preparative reactions and their products. Beilstein & Gmelin, while currently
indexing a much smaller number of journals, are much more comprehensive in their coverage of the
synthetic chemistry literature, since their primary focus is on chemical compounds, their physical
properties and reactions. CAS, per its stated policy, focuses on 'new"' information and the main point
of the article.



Beilstein/Gmelin vs CCD vs SciFinder Scholar

SciFinder Scholar (Chemical Abstracts Plus) has completely different criteria for indexing
articles than Beilstein/Gmelin or the Combined Chemical Dictionary.

Chemical Abstracts, per its stated policy, covers the full range of the 'chemical’ literature,
focusing on 'new' information and the main points of the article or patent, etc. This differs significantly
from B/G and the CCD which index a small subset of chemical journals, focusing on the synthetic
chemistry literature. Their primary focus is on compounds, physical properties and reactions.

Thus, the indexing of documents (SFS) vs. indexing compounds (B/G & CCD) obviously leads
to significant differences in retrieval. In addition, the extensive coverage of the patent literature in
SFS (which Beilstein & Gmelin dropped after 1979, and the CCD covers very selectively) strongly
suggests that compound searches should be performed in all three databases.

SciFinder Scholar's Registry File contains over 43M substances, while Beilstein/Gmelin have
indexed 9.2M organic and 1.5M inorganic/organometallic compounds respectively. The CCD only
lists 486K organic compounds and natural products and 102K inorganic/organometallic compounds.
A comparison of results from the four databases highlights the need to search all three databases.
For example:

Lithium, [2-(dimethylamino)phenyl]-(SFS) [2-(Dimethylaminophenyl)] lithium (SFS,CCD)
2-Dimethylaminophenyllithium (B)  2-(dimethylamino)phenyllithium (G)
C8H10LIN -- 22608-37-3

Beilstein: 5 references (4 as a reactant and 1 preparation) from 1977-1997.
The preparation reference is unique to Beilstein.

Gmelin: 14 references as a reactant (including a German patent) from 1943-1990

CCD: 6 references (5 preparation and 1 use) from 1966-1990, including a book chapter.
3 of the preparation references are unique to the CCD.

SFES(CA): 31 references, from 1969-2001, of which 7 describe preparation. The 1977 Beilstein
synthesis reference is not included in SFS, since the main point of the article was the reactivity
of the starting materials. 4 of the preparation references are unique to SFS.

Brian M. Stoltz (as an author)
Beilstein: 20 references (including 2 with Stoltz misspelled at Stolz. The most recent being
Angew. Chem. Int. Ed.; 2003, 42(9). Beilstein didn't index (TL 1999, 40, 2061).
Gmelin: 5 references (all in Beilstein). The most recent being JACS; 2002; 124(42)
SFS(CA): 56 references (including all the references in Beilstein and Gmelin). In addition,
there are references to his thesis, a patent, ACS Abstracts -- as well as a recent Tetrahedron

article (2003; 59(45) article. There was also a synthesis article indexed in SFS that should
have been indexed in Beilstein



CrossFire Documentation and Help:

MDL CrossFire Commander Version 6 (2002) (Caltech Splash Page)

MDL CrossFire Commander V6 -- Quick Reference Guide

CrossFire Beilstein Brochure

CrossFire Beilstein Data Fields Reference Guide (v.6)
CrossFire Beilstein Tips and Hints on Certain Fields

CrossFire Beilstein Tutorial

List of ... journals covered in the Beilstein Database

CrossFire Gmelin Brochure

CrossFire Gmelin Database Reference Guide

List of ... journals covered in the Gmelin Database

Autonom Brochure

For searching tips, consult these guides:

Beilstein and Gmelin Databases (UW-Madison)

Structure Searching: Quick Review - 2002 (Caltech)

University of Chicago Web Guides for Beilstein CrossFire

Other Web Guides for Beilstein CrossFire

ADDENDUM TO 'PREDEFINED GENERIC GROUPS' PAGE


http://library.caltech.edu/publications/beilstein/default.htm
http://www.mdl.com/products/pdfs/cfb_brochure.pdf
http://www.beilstein.com/products/xfire/
http://www.beilstein.com/faq/tips.shtml
http://www.beilstein.com/products/xfire/howto/1.shtml
http://www.mdl.com/products/pdfs/BSJournals.pdf
http://www.mdl.com/products/pdfs/cfg_brochure.pdf
http://www.mdl.com/products/pdfs/GMJournals.pdf
http://chemistry.library.wisc.edu/beilstein/home.htm
http://library.caltech.edu/learning/classhandouts/Structure2002.pdf
http://www.lib.uchicago.edu/e/su/chem/ucbeil.html
http://www.beilstein.com/internet/internet.shtml

Predefined Atom Lists

A
AH

Q
QH
M
MH
X
XH

Any atom

Any atom or Hydrogen

Any atom except Carbon or Hydrogen
Any atom except Carbon

Any metal atom

Any metal atom or Hydrogen

Any Halogen

Any Halogen or Hydrogen



Workshop Exercises

1. Work thru exercises given at:

http://chemistry.library.wisc.edu/beilstein/exercises.htm

http://www.mimas.ac.uk/crossfire/examples/examples bs structure.html

2. Find Pharmacological information on the Chinese
herb Quinghaosu (Artemisia Annua) which has been
used in the treatment of malaria.

The search requires finding compounds isolated from a natural product (INP field) that mention
malaria or antimalarial in the (PHARM.COM field).

Introduction

Ask group : Who knows what Beilstein means? Generally I've found that no one knows. So that's
the introduction to explaining that Beilstein is the last name of German chemistry professor of the
19th century who personally compiled and edited the first three editions of the Handbook of
Organic Chemistry. Essentially his surname, Beilstein, has become synonymous with his life's
work.

Show picture...

Biographical on Friedrich Konrad Beilstein: .b 1838 in St. Petersburg, Russia of German parents.
Educated in Germany and recieved his doctorate at University of Goettingen where he began his
professional career. He relocated to the Technical Institute in St. Petersburg in 1866 where in
remained until his death in 1906.

First edition of the Handbook published in 1881 including 15,000 compounds documented in the
literature back into the 1700's (1789). By the 1990's there were 7.5 M compounds and 10M
reactions documented. The fourth edition of 1938 published by the German Chemical Society
appeared after his death and covered the literature up to 1910. F. K. Beilstein devised the
organization of the compounds into 27 logical volumes by compund class (e.g. Acyclics,


http://chemistry.library.wisc.edu/beilstein/exercises.htm
http://chemistry.library.wisc.edu/beilstein/exercises.htm

Isocyclics, Heterocyclics).... Here | usually ask if anyone has used the print Handbook - | haven't
found anybody yet! To add data - supplements were published. Supplements to the fourth edition
cover the literature up through 1979 but took into the 1990's to publish. Adding physical print
supplements to the logical arrangement made use very cumbersome. This hurdle and time lag and
cost - most individual volumes cost $1000 dollars or more - caused most research libraries to
suspend their subscription. For the literature after 1979, Beilstein coverage was limited to 120 core
or significant organic chemistry journals. Beilstein focuses on structure, properties, reactions and
does not cover all uses and applications. Therefore, depending on need, it may be necessary to
search BOTH Beilstein and CAS.

| use the scenario of what happened to the publishing of this Handbook to illustrate the general
problem of cost/access/ scholarly communication.

Current statistics: LOGIN FIRST dzrlib ...

Home > Support > Knowledge Base > Product Release Information >

Select <CrossFire Beilstein and Gmelin Databases> from Select Product drop-down Menu.
Then Download .PDF file.

dzrlib@library.caltech.edu http://library.caltech.edu/collections/chemistry.htm

BEILSTEIN CrossFire Beilstein

BS0303 BS0304 4 Microsoft Windows 2000
BRN: 9259 K *

RxID: 8773 K T

CNR: 1875 K t

GMELIN CrossFire Gmelin

GMO0302 GM0303 4 Microsoft Windows 2000
GRN: 1501 K *

RxID: 1897 K t

CNR: 1007 K t

Version 6, you can disable LitLink.In the xf.ini file change the LITLINK=Yes to LITLINK=No .This ini file is
located at c:\program files\mdl crossfire commander v6\xf.ini

From the original Gmelin Handbook up to the year 1975 more than 99 % is in
CrossFire Gmelin. The only parts we did not add are what went into CrossFire
Beilstein (a matter of definition) and some volumes that do not deal with
chemistry, like the one about Geology of lron.

The handbooks published after 1975 are not included in CrossFire Gmelin,
however the excerpts of the 120 most important journals (Year 1976 to 1995)
are in the database. This would be the source of the handbooks that would
have made their way into CrossFire Gmelin anyway, so there is no loss.

The time between 1995 and 2001 is handled by our partner GDCh.


http://library.caltech.edu/collections/chemistry.htm

Since 2001 MDL Information System GmbH is responsible for the data.

Dr. Jochen Tannemann

Product Manager

MDL Information Systems GmbH
mail: j.tannemann@mdl.com

As you might know MDL started to maintain the Gmelin Database iIn the
beginning of the year 2000 in close cooperation with the Gesellschaft
Deutscher Chemiker. The closing of the Gmelin Institute as a Governmentally
funded institution in the year 1995 left a gap of nearly 5 years in the
abstraction of the literature. The Gesellschaft Deutscher Chemiker will
close this gap very soon. To keep continuity we started in 2000 to abstract
the journals which were already abstracted before by the Gmelin Institute.
Unfortunately the start of Inorganic Chemistry Communications in 1998 does
lie in between the five-year gap.

However we are constantly evaluating new journals concerning their necessity
for improvement of the Gmelin Database for the benefit of our users. We will
evaluate this journal as soon as possible.

Dr. Christian Druckenbrodt
MDL Information Systems GmbH
Database Development
Theodor-Heuss-Allee 108
D-60486 Frankfurt, Germany

Tel.: (+49) 69/ 5050 4258
Fax: (+49) 69/ 5050 4266
eMail: C.Druckenbrodt@mdl.com

Just noticed that Gmelin isn"t covering Acta Cryst. E (the new Structure
>Reports Online) nor Inorganic Chemistry Communications. Since Inorg. Chem.
>Commun. s a twig that "Aims to replace the (Preliminary) Communication
>section of Inorganica chimica acta, Polyhedron and the Journal of
>organometallic chemistry" this would seem like an obvious and highly
>necessary addition to the Gmelin database.

VVVYVYVm

Therefore, if you search for ANY preparation of B, do a compound search for B

filter all reactions "... as product(this, again, works only on the '"reactions', NOT on
the "non-graphical' reactions that are left alone by this filter !) and in addition,
check for the "preparations' in the NON-graphical recations - they may contain important
information

BS0501

Highest BRN: 9.844.397

No. of compounds: 9.218.418
Highest Rx.1d: 9.711.590

No. of reactions: 9.677.538
Highest CNR: 6.465.790

No. of citations: 1.949.390
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